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Preface

Thank you for purchasing the DocuPrint P215 b.

This guide is intended for users who use the printer for the first time, and provides all the necessary 
operating information about the printer function.

Please read this guide to achieve the best performance from this printer.

This guide assumes you are familiar with computers.

After reading this guide, keep it safe and handy for future reference.

DocuPrint P215 b User Guide Help

Copyright© 2013 by Fuji Xerox Co., Ltd.

Fuji Xerox Co., Ltd.

July 2013 (Edition 1)

No. ME6449E2-1
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Trademarks and Document Disclaimer

Apple®, Bonjour®, ColorSync®, Macintosh®, and Mac OS® are trademarks of Apple Inc. in the United 
States and/or other countries.

Microsoft®, Windows Vista®, Windows®, and Windows Server® are trademarks of 
Microsoft Corporation in the United States and/or other countries.

All product/brand names are trademarks or registered trademarks of the respective holders.

XEROX, the sphere of connectivity design, and DocuPrint are trademarks or registered trademarks of 
Xerox Corporation in the U.S. or Fuji Xerox Co., Ltd. 

DocuWorks is a trademark of Fuji Xerox Co., Ltd. 

All Xerox and Fuji Xerox product names are either registered trademarks or trademarks of Xerox 
Corporation or Fuji Xerox Co., Ltd.

In this manual, safety instructions are preceded by the symbol . Always read and follow the instructions 
before performing the required procedures.

IMPORTANT: 

1. This manual is copyrighted with all rights reserved. Under the copyright laws, this manual may not be copied 
or modified in whole or part, without the written consent of the publisher.

2. Parts of this manual are subject to change without prior notice.

3. We welcome any comments on ambiguities, errors, omissions, or missing pages.

4. Never attempt any procedure on the machine that is not specifically described in this manual. Unauthorized 
operation can cause faults or accidents. Fuji Xerox is not liable for any problems resulting from unauthorized 
operation of the equipment.

5. Decompiling this manual is prohibited.

An export of this product is strictly controlled in accordance with Laws concerning Foreign Exchange and 
Foreign Trade of Japan and/or the export control regulations of the United States.
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Types of Manuals

Safety Guide Describes the information you need to know before using the printer 
and to operate the printer safely.

Setup Guide Provides step-by-step instructions on how to set up your printer.

User Guide (HTML File) 
(this guide)

Describes how to get ready to print and set various features. It also 
covers the operator panel indicators, troubleshooting tips, and 
maintenance information.

This guide is on the Software Pack CD-ROM.

Operator Panel Guide Describes the icons assigned to the buttons or indicators on the 
operator panel.
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Using This Guide

This section includes:

• "Organization" on page 9

• "Conventions" on page 10
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Organization
This guide is organized into the following chapters. The summary of each chapter is as follows:

1 Specifications Describes the printer specifications.

2 Basic Operation Describes the main components of the printer, the power saver mode, 
and how to turn on the printer.

3 Printer Management Software Describes the software available for the printer.

4 Installing the Print Driver Describes the basic information about how to connect the printer to 
your computer and how to install the print driver.

5 Printing Basics Describes the supported paper, how to load paper, and how to print 
data using various print features.

6 Using the Operator Panel Describes the indicators on the operator panel.

7 Troubleshooting Describes the troubleshooting tips for printer problems such as paper 
jams.

8 Maintenance Describes how to clean the printer, how to replace toner cartridges, 
and how to see the printer status.

9 Contacting Fuji Xerox Describes support information.
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Conventions

1 In this guide, personal computers and workstations are collectively called “computers”.

2 The following terms are used throughout this guide:

IMPORTANT: 

• Important information that must be read and followed.

NOTE: 

• Additional information that merits emphasis.

See also: 
• References within this guide.

3 Orientation of documents or paper is described in this guide as follows:

, ,Long Edge Feed (LEF): Loading the document or paper in landscape orientation.

, ,Short Edge Feed (SEF): Loading the document or paper in portrait orientation.

LEF Orientation SEF Orientation

Paper feed direction Paper feed direction
Using This Guide 10



Safety Notes

Before using this product, read “Safety Notes” carefully for safety use.

This product and recommended supplies have been tested and found to comply with strict safety 
requirements including safety agency approvals and compliance with environmental standards. Follow 
the following instructions for safety use.

Follow all warning instructions marked on this product. The warning marks stand for the followings:

WARNING:

• Any unauthorized alteration including an addition of new functions or connection to external devices 
may not be covered by the product warranty. Contact your local Fuji Xerox representative for more 
information.

Used for item that if not followed strictly, can lead death or severe or 
fatal injuries and the possibility to do it is comparatively high.

Used for items that if not followed strictly, can lead to severe or fatal 
injuries.

Used for items that if not followed strictly, can cause injuries to user or 
damages to machine.

: A symbol for items to pay attention to when handling machine. 

Follow instructions carefully to use machine safely.

: A symbol for prohibited items. Follow instructions carefully to avoid 
any dangerous acts.

: A symbol for items that must be performed. Follow instructions 
carefully to carry out these essential tasks.

Caution Flammable Explodable Electric 
shock

Heated 
surface

Moving 
object

Pinched 
fingers

Prohibited No fire Do not touch Do not use in 
bathroom

Do not tear 
down

Keep away 
from wet

Never touch 
with wet hand

Instructions Unplug Ground/ 
Earth
11 Safety Notes



Electrical Safety

 WARNING
This product shall be operated by the power source as indicated on the product's data plate. Consult 
your local power company to check if your power source meets the requirements.

 CAUTION

WARNING:

• Connect this product to a protective earth circuit.

This product is supplied with a plug that has a protective earth pin. The plug fits only into an 
earthed electrical outlet. This is a safety feature. If the plug doesn't fit to the outlet, contact an 
electrician to replace the outlet to avoid risk of electric shock. Never use an earthed adapter 
plug to connect the product to the electrical outlet that has no earth connection terminal.

Improper connection of a grounding conductor may cause electric shock.

Plug the power cord directly into a grounded electrical outlet. To prevent overheat and a fire 
accident, do not use an extension cord, a multi-plug adaptor or a multiple connector. Consult 
your local Fuji Xerox representative to check if an outlet is grounded.

Connect this product to a branch circuit or an outlet that has larger capacity than the rated 
ampere and voltage of this product. See the data plate on the rear panel of this product for its 
rated ampere and voltage.

Never touch the power cord with wet hands. It may cause electric shock.

Do not put an object on the power cord.

Always keep the plug connection free of dust. The dusty and damp environment may bring 
about minute electric current in a connector. It may generate heat and eventually cause a fire 
accident.

To avoid the risk of electric shock and a fire accident, only use the power cord supplied with this 
product or the ones designated by Fuji Xerox.

The power cord is exclusive use for this product. Do not use it for any other product.

Do not damage or alter the power cord. Damage and alteration may generate heat and 
eventually cause electric shock or a fire accident.

If the power cord is damaged or insulated wires are exposed, contact your local Fuji Xerox 
representative for its replacement. Do not use a damaged or uninsulated cord to avoid the risk 
of electric shock and a fire accident.

When cleaning this product, always switch off and unplug it. Access to a live machine interior 
may cause electric shock.

Do not unplug or re-plug this product with the switch on. Plugging and unplugging a live 
connector may deform the plug and generate heat, and eventually cause a fire accident.

Hold the plug not the cord when unplugging this product, or it may damage the cord and cause 
electric shock or a fire accident.
Safety Notes 12



Always switch off and unplug the machine when it is not used over weekends or long holidays. 
It may cause deterioration of insulations and eventually electric shock or a fire accident.

Once a month, switch off this product and check if

• the power cord is plugged firmly into an electrical outlet;

• the plug is not excessively heated, rusted or bent;

• the plug and electrical outlet are free of dust; and

• the power cord is not cracked or worn down.

Once you notice any unusual condition, switch off and unplug this product first and contact your 
local Fuji Xerox representative.
13 Safety Notes



Machine Installation

 WARNING

 CAUTION

Do not locate this product where people might step on or trip over the power cord. Friction or 
excessive pressure may generate heat and eventually cause electric shock or a fire accident.

Never locate this product in the following places:

• Near radiators or any other heat sources

• Near volatile flammable materials such as curtains

• In the hot, humid, dusty or poorly ventilated environment

• In the place receiving direct sunlight

• Near cookers or humidifiers

Locate this product on a level and sturdy surface that can withstand a weight of 4.6 Kg. 
Otherwise, if tilted, the product may fall over and cause injuries.

Locate this product in a well-ventilated area. Do not obstruct ventilation openings of the 
product. 

Keep the minimum clearance as follows for ventilation and an access to the power plug. 
Unplug the product if an abnormal condition is noted.

Do not incline the product at more than 10 degree angle. Otherwise, it may fall over and cause 
injuries.

To bundle wires and cables, always use the cable ties and spiral tubes that Fuji Xerox supplies. 
Otherwise, it may cause some defects.

558 mm

404 mm

200 mm

200 mm

100 mm

100 mm

100 mm
100 mm

100 mm

928 mm 928 mm

10° 10° 10° 10°

Left FrontRight BackLeft FrontRight Back
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Others

To keep this product in a good performance and condition, always use it in the following 
environment: 

• Temperature: 10 – 32 °C

• Humidity: 10 – 85 %

When the product is left in a chilly room and the room is rapidly warmed up by heater, dew 
condensation may form inside the product and cause a partial deletion on printing.
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Operational Safety

 WARNING

The operator's product maintenance procedures are described in the customer documentation 
supplied with this product. Do not carry out any other maintenance procedures not described in 
the documentation.

This product features safety design not to allow operators access to hazard areas. The hazard 
areas are isolated from operators by covers or protectors which require a tool to remove. To 
prevent electric shock and injuries, never remove those covers and protectors.

To avoid the risk of electric shock and a fire accident, switch off and unplug the product 
promptly in the following conditions, then contact your local Fuji Xerox representative.

• The product emits smoke or its surface is unusually hot.

• The product emits unusual noise or odor.

• The power cord is cracked or worn down.

• A circuit breaker, fuse or any other safety device becomes activated.

• Any liquid is spilled into the product.

• The product is soaked in water.

• Any part of the product is damaged.

Do not insert any object into slots or openings of this product.
Do not put any of the followings on the product:

• Liquid container such as flower vases or coffee cups

• Metal parts such as staples or clips

• Heavy objects

If liquid is spilled over or metal parts are slipped into the product, it may cause electric shock or 
a fire accident.

Do not use conductive paper such as origami paper, carbonic paper or conductively-coated 
paper. When paper jam occurs, it may cause short-circuit and eventually a fire accident.

When cleaning this product, use the designated cleaning materials exclusive to it. Other 
cleaning materials may result in poor performance of the product. Never use aerosol cleaners 
to avoid catching fire and explosion.

Never play the CD-ROM supplied with the product on an audio player. Always use a CD-ROM 
player. Otherwise, large sound may damage audio players or your ears.

Laser Safety

CAUTION: Any operations or adjustments not stated in the operation manual may cause 
hazardous light exposure and eventually burn injuries or loss of eyesight.

This product has been tested and found to comply with the Class 1 Laser Equipment 
requirements defined by the international standard IEC60825 and has no light exposure 
hazard. The product has no hazardous light emission as it features light protection components 
and covers to shut in all light beam during operation and maintenance.
Safety Notes 16



 CAUTION

Always follow all warning instructions marked on or supplied with this product.

To avoid the risk of burn injuries and electric shock, never touch the area with the “High 
Temperature” or “High Voltage” marks on.

Keep electrical and mechanical safety interlocks active. Keep the safety interlocks away from 
magnetic materials. Magnetic materials may accidentally activate the product and cause 
injuries or electric shock.

Do not attempt to remove a paper deeply jammed inside the product, particularly a paper 
wrapped around the fusing unit or the heat roller. Otherwise, it may cause injuries or burns. 
Switch off the product immediately and contact your local Fuji Xerox representative.

Do not apply excessive force to hold thick document on the document glass. It may break the 
glass and cause injuries.
17 Safety Notes



Consumable

 WARNING

 CAUTION

Store all consumables in accordance with the instructions given on its package or container.

Never use a vacuum cleaner for spilled toner and residual toner in this product, toner cartridge 
or toner bottle.

It may catch fire by electric sparks inside a vacuum cleaner and cause explosion.

Use a broom or a wet cloth to wipe off the spills. If you spill a large volume of toner, contact 
your local Fuji Xerox representative.

Never throw a toner cartridge into an open flame. 
Remaining toner in the cartridge may catch fire and cause burn injuries or explosion.

If you have a used toner cartridge no longer needed, contact your local Fuji Xerox 
representative for its disposal.

Keep drum cartridges (or drum if not a cartridge type) and toner cartridges out of the reach of 
children. If a child accidentally swallows toner, spit it out, rinse mouth with water, drink water 
and consult a physician immediately.

When replacing drum cartridges (or drum if not a cartridge type) and toner cartridges, be 
careful not to spill the toner. In case of any toner spills, avoid contact with clothes, skin, eyes 
and mouth as well as inhalation.

If toner spills onto your skin or clothing, wash it off with soap and water.

If you get toner particles in the eyes, wash it out with plenty of water for at least 15 minutes until 
irritation is gone. Consult a physician if necessary.

If you inhale toner particles, move to a fresh air location and rinse your mouth with water.

If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
Safety Notes 18



Warning and Caution Labels
Always follow all warning instructions marked on or supplied with this product.

To avoid the risk of burn injuries and electric shock, never touch the area with the "High Temperature" 
or "High Voltage" marks on.
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Environment

• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner 
cartridges or toner containers and drums (photoreceptors) to make recycle parts, recycle 
materials or energy recovery.

• Proper disposal is required for toner cartridges no longer needed. Do not open toner cartridges. 
Return them to your local Fuji Xerox representative.
Environment 20



Regulation

Radio Frequency Emissions (Class B)

Product Safety Certification (CB)
This product is certified by the following agency using the safety standards listed.

This product has been tested and found to comply with the limits for a Class B digital device, 
pursuant to the International Standard for Electromagnetic Interference (CISPR Publ. 22) and 
Radiocommunications Act 1992 in Australia/New Zealand. These limits are designed to 
provide reasonable protection against harmful interference in a residential installation. This 
product generates, uses and can radiate radio frequency energy and, if not installed and used 
in accordance with the instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular installation. If this 
product does cause harmful interference to radio or television reception, which can be 
determined by turning this product off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between this product and the receiver.

• Connect this product into an outlet on a circuit different from that to which the receiver is 
connected.

• Consult the dealer or an experienced radio/TV technician for help.

Changes and modifications to this product not specifically approved by Fuji Xerox may void the 
user’s authority to operate this product.

Agency Standard

Intertek IEC60950-1:ed. 2
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Illegal Copies and Printouts

Copying or printing certain documents may be illegal in your country. Penalties of fines or 
imprisonment may be imposed on those found guilty. The following are examples of items that may be 
illegal to copy or print in your country. 

• Currency

• Banknotes and checks

• Bank and government bonds and securities

• Passports and identification cards

• Copyright material or trademarks without the consent of the owner

• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel.
Illegal Copies and Printouts 22



Product Features

This chapter describes the product features and indicates their links.

Manual Duplex Print

Duplex Print is to print two or more pages on the 
front and back sides of a single sheet of paper 
manually. This feature allows you to reduce the 
paper consumption.

For more information, see "Manual Duplex 
Printing" on page 74.

Multiple-Up Print

Multiple-Up enables you to print multiple pages 
on a single sheet of paper. This feature allows 
you to reduce the paper consumption.

For more information, see the print driver's help.

Fuji Xerox Imaging Technology

The high-resolution LED print head (1200 x 1200) and IE Technology* produce smoother lines.

* Image Enhancement Technology

1,200 dpi

Conventional technology

Jagged line

Enhanced image

Smooth line
23 Product Features
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1
Specifications

This chapter lists the main specifications of the printer. Note that the specifications may change 
without prior notice.

Items Description

Type Desktop

Printing method LED Xerography

IMPORTANT: 

• LED + LED electrophotographic system

Fusing system Thermal fusing system using a belt

Warm-up Time Less than 25 seconds (after powering on at 20 °C temperature) 

Continuous print speed*1 A4 : When plain paper is fed from the Multipurpose feeder (MPF)

Monochrome 1 Sided*2: 24 sheets/min

IMPORTANT: 
*1 Print speed may decrease due to factors such as paper type, paper size, 

and printing conditions.
*2 When continuously printing a single document of A4 .

First print Monochrome 11 seconds (A4 /Fed from the Multipurpose feeder 
(MPF))

IMPORTANT: 

• Measurements based on Fuji Xerox test pattern. Time from printer 
startup until output of the first page is complete. Except the time 
when the printer controller receives or processes the print data.

Resolution Standard: 600 × 600 dpi

High Resolution: 1200 × 1200 dpi*
*: When printing in high resolution mode, printing speed may be reduced 

due to image quality adjustment. Printing speed may also be reduced 
depending on documents.

Tone 256 tones
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Paper Size A4, B5, A5, Letter (8.5 × 11"), Executive (7.25 × 10.5"), Legal 13 
(Folio) (8.5 × 13"), Legal 14 (8.5 × 14"), Statement, Envelope (Com-
10, Monarch, DL, C5), Postcard (100 × 148 mm), Postcard (148 × 200 
mm), Yougata 2, Yougata 3, Yougata 4, Yougata 6, Younaga 3, 
Nagagata 3, Nagagata 4, Kakugata 3, Custom Paper (Width: 76.2 – 
215.9 mm, Length: 127 – 355.6 mm)

Image loss: 4.0 mm from the top, bottom, left, and right edges

Paper Type Plain, Lightweight Cardstock, Labels, Envelope, Recycled, Postcard 
JPN

IMPORTANT: 

• Use only the recommended paper. Using paper other than that 
recommended for the printer can cause printing problems. For 
more information, see "Print Media That Can Damage Your 
Printer" on page 58.

• Note that poor printing quality due to paper-related printing 
problems can occur when using the printer in an environment that 
is dry, cold, or very humid. 

• Printing over the printed side or on the reverse side of paper that 
already has been printed on can result in poor print quality.

• When printing on envelopes, use envelopes that do not have 
adhesive applied.

• The type of paper being used and environmental conditions can 
affect printing quality. Because of this, it is recommended that you 
test print and confirm proper print quality before using the printer.

Paper capacity Standard:

Multipurpose feeder (MPF): 150 sheets

IMPORTANT: 

• Fuji Xerox P paper (64 gsm)

Output tray capacity Standard: approximately 100 sheets (face down)

IMPORTANT: 

• Fuji Xerox P paper (64 gsm) 

2-sided Printing Feature Standard (Manual)

CPU 4305/150MHz 

Memory capacity Standard: 64MB (Onboard)

IMPORTANT: 

• The above memory capacity does not guarantee print quality 
depending on the type and content of print data. 

Hard disk —

Page Description Language — (Host-based)

Items Description
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Supported OS*1 Windows® XP, Windows® XP x64 Edition, Windows Vista®, Windows 
Vista® x64 Edition, Windows Server® 2003, Windows Server® 2003 
x64 Edition, Windows Server® 2008, Windows Server® 2008 x64 
Edition, Windows Server® 2008 R2 x64 Edition, Windows® 7, 
Windows® 7 x64 Edition, Windows® 8, Windows® 8 x64 Edition, 
Windows Server® 2012 x64 Edition, Mac OS®*2

IMPORTANT: 
*1 For the latest information about the supported operating systems, contact 

our Customer Support Center or your dealer.
*2 Mac OS® X 10.4.11/10.5.8 - 10.8 are supported.

Interface Standard: USB 2.0 (Hi-Speed)

Power AC 110 - 127 V ± 10%; 8 A; both 50/60 Hz

AC 220 - 240 V ± 10%; 4 A; both 50/60 Hz

IMPORTANT: 

• Maximum machine measured current

Operating noise

(main unit only)

During operation: 6.6 B, 51.7 dB (A)

During stand-by: 2.98 B, 15 dB (A)

IMPORTANT: 

• Measurements based on ISO7779
Unit B: acoustic power level (LwAd)
Unit dB (A): radiated sound pressure (bystander position)

Power consumption Maximum: 990 W, During the Sleep mode: 4.0 W or less

Average: 

During standby: 62 W, 

During continuous monochrome printing: 380 W

IMPORTANT: 

• Low Power Mode: 7.8 W average

Dimensions (main unit only) 358 (W) × 197 (D)*1 × 208 (H) mm

IMPORTANT: 
*1 When the Multipurpose feeder (MPF) is closed.

Weight 4.6 kg (including consumables)

Usage Environment Temperature: 10 - 32 °C; Humidity: 10 - 85% (except malfunctions 
due to dew condensation)

Non-Use: Temperature: -10 – 40 °C; Humidity: 5 – 85% (except 
malfunctions due to dew condensation)

IMPORTANT: 

• Until the conditions (temperature and humidity) inside the printer 
become acclimated to the installation environment, certain 
qualities of the paper can cause poor printing. 

Items Description
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2
Basic Operation

This chapter includes:

• "Main Components" on page 30

• "Turning On the Printer" on page 34

• "Power Saver Mode" on page 35
29 Basic Operation



Main Components

This section provides an overview of your DocuPrint P215 b.

This section includes:

• "Front View" on page 31

• "Rear View" on page 32

• "Operator Panel" on page 33
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Front View

1 Output Tray Extension 2 Center Output Tray

3 Operator Panel 4 Power Switch

5 Toner Access Cover 6 Paper Width Guides

7 Multipurpose Feeder (MPF) 8 Front Cover

9 Slide Bar 10 Length Guide

11 Paper Cover*

* The paper cover is used as a tray to feed paper into the PSI as well as a cover to protect the paper 
loaded on the MPF.

11 10 9 8 7 6

4321

5
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Rear View

1 Levers 2 Transfer Drum

3 Paper Feed Roller 4 Paper Chute

5 Transfer Roller 6 Rear Cover

7 Rear Cover Handle 8 Power Connector

9 USB Port

1

2

7

5

3
4

68

9
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Operator Panel
The operator panel has one button and two light-emitting diodes (LEDs) that show the status of the 
printer.

1  (Error) LED 

• Indicates an error occurred.

2  (Ready) LED

• Indicates the printer status such as ready to print.

3 Button

• Press this button to start duplex printing after loading paper.

• Press and hold this button during printing to cancel a print job.

• Press this button to exit the Power Saver mode.

• Press this button to continue a pending job in an error state such as misfeeding after checking 
that paper is loaded properly.

The LEDs provide information on the status of the printer.

See also: 
• "Understanding the Operator Panel Lights" on page 95

LED Status Condition

Error Umber on An error occurred.

Umber blinks A fatal error occurred.

Ready Green on The printer is ready to print.

Green blinks The printer is receiving, printing, or waiting for print data.

Green blinks slowly The printer is in the Power Saver mode.

1

2

3
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Turning On the Printer

IMPORTANT: 

• Do not use extension cords or power strips.

• The printer should not be connected to an uninterruptible power supply (UPS) system.

1 Connect the power cord to the power connector on the rear of your printer.

2 Connect the other end of the cord to the power source.

3 Turn on the printer.
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Power Saver Mode

The printer has a power saving feature which reduces power consumption during periods of inactivity. 
This feature operates in two modes: the Low Power mode and Sleep mode. By factory default, the 
printer switches to the Low Power mode one minute after the last job is finished. The printer then 
switches to the Sleep mode after another 6 minutes of inactivity. In the Power Saver mode, the  
(Ready) LED blinks slowly.

The factory default settings are changeable within the range of 1 - 30 minutes (Low Power mode) and 
6 - 11 minutes (Sleep mode). The printer returns to the ready-to-print state in about 25 seconds when 
re-activated.
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Setting the Time for the Power Saver Mode
You can specify the time for the Power Saver mode. The printer switches to the Power Saver mode 
after the specified time.

The following procedure uses Microsoft® Windows® 7 as an example.

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
DocuPrint P215 b → Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step, when multiple print drivers are installed on 
your computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Maintenance tab.

3 Select System Settings from the list at the left side of the page.

The System Settings page is displayed.

4 Specify Low Power Timer and Sleep Timer in Power Saver Timer.

5 Click the Apply New Settings button to take effect.
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Exiting the Power Saver Mode
The printer automatically exits the Power Saver mode when it receives a job from a computer. To 
manually exit the Power Saver mode, press the button on the operator panel.
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3
Printer Management Software

Use the Software Pack CD-ROM that is shipped with your printer to install a combination of software 
programs, depending on your operating system.

This chapter includes:

• "Print Driver" on page 40

• "Printer Setting Utility (Windows Only)" on page 41

• "SimpleMonitor (Windows Only)" on page 42

• "Launcher (Windows Only)" on page 43
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Print Driver

To access all of your printer’s features, install the print driver from the Software Pack CD-ROM.

The print driver enables your computer and printer to communicate and provides access to your 
printer features.

See also: 
• "Installing Print Driver on Computers Running Windows" on page 48

• "Installing Print Driver on Computers Running Mac OS X" on page 51
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Printer Setting Utility (Windows Only)

The Printer Setting Utility allows you to view or specify the system settings. You can also diagnose the 
system settings by using the Printer Setting Utility.

The Printer Setting Utility consists of the Printer Settings Report, Printer Maintenance, and 
Diagnosis tabs.

The Printer Setting Utility can be installed from the Software Pack CD-ROM.
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SimpleMonitor (Windows Only)

You can check the printer status with the SimpleMonitor. Double-click the SimpleMonitor printer icon 
on the taskbar at the bottom right of the screen. The Printer Selection window appears, which 
displays the printer name, printer connection port, and printer status. Check the column Status to 
know the current status of your printer. 

Settings button: Displays the Settings screen and allows you to modify the SimpleMonitor settings.

Click the name of the desired printer listed on the Printer Selection window. The Printer Status 
window appears.

The Printer Status window alerts you when there is a warning or when an error occurs, for example, 
when a paper jam occurs or toner is running low.

By default, the Printer Status window launches automatically when an error occurs. You can specify 
the conditions for starting the Printer Status window in Printer Status Window Properties. 

To change the pop-up settings for the Printer Status window:

1 Right-click the SimpleMonitor printer icon on the taskbar at the bottom right of the screen.

2 Select Printer Status Window Properties.

The Printer Status Window Properties window appears.

3 Select the type of the pop-up and then click OK.

You can also check the toner level of your printer on the Printer Status window.

The SimpleMonitor can be installed from the Software Pack CD-ROM.
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Launcher (Windows Only)

Using the Launcher window, you can open the Status Window, Printer Setting Utility, and 
Troubleshooting.

The following procedure uses Microsoft® Windows® 7 as an example.

To open the Launcher window:

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
DocuPrint P215 b → Launcher.

The Launcher window appears.

2 The Launcher window provides three buttons; Status Window, Printer Setting Utility, and 
Troubleshooting.

To exit, click the X button at the top-right of the window.

For details, click the Help button/icon of each application.

The Launcher can be installed from the Software Pack CD-ROM.

Status Window Click to open the Printer Status window. 

See also: 
• "SimpleMonitor (Windows Only)" on page 42

Printer Setting Utility Click to open the Printer Setting Utility. 

See also: 
• "Printer Setting Utility (Windows Only)" on page 41

Troubleshooting Click to open the Troubleshooting guide, which allows you to resolve 
issues by yourself.
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4
Installing the Print Driver

This chapter includes:

• "Connecting Your Printer" on page 46

• "Installing Print Driver on Computers Running Windows" on page 48

• "Installing Print Driver on Computers Running Mac OS X" on page 51
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Connecting Your Printer

Your DocuPrint P215 b interconnection cable must meet the following requirement:

Connection Type Connection Specifications

USB USB 2.0 compatible

1 USB Port

1
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Connecting Printer to Computer
Connect the printer via USB. A USB connection is a direct connection and is not used for networking.

The available feature is shown in the following table.

USB Connection
To attach the printer to a computer:

1 Ensure that the printer and computer are turned off and unplugged from the power source/outlet.

2 Connect the smaller USB connector into the USB port at the back of the printer and the other end 
of the cable into the USB port of the computer.

NOTE: 
• Do not connect the printer USB cable to the USB connector available on the keyboard.

Connection Type Available Feature

USB You can instruct print jobs from a computer.

USB port
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Installing Print Driver on Computers Running 
Windows

This section includes:

• "Inserting the Software Pack CD-ROM" on page 49

• "USB Connection Setup" on page 50
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 Inserting the Software Pack CD-ROM

1 Insert the Software Pack CD-ROM into your computer’s CD-ROM drive to start Easy Install 
Navi.

NOTE: 

• For Windows 8 and Windows Server 2012, click on the message displayed on the upper right corner of 
the screen, and then select Run setup.exe.

• If the CD does not automatically launch, perform the following steps.

a For Windows XP, Windows Server 2003, Windows Server 2008 and Windows Server 2008 R2, click 
Start (start for Windows XP) → Run.
For Windows Vista and Windows 7, click Start → All Programs → Accessories → Run.
For Windows 8 and Windows Server 2012, right-click on the Start screen and click All apps → Run.

b Enter "D:\setup.exe" (where D is the drive letter of your computer's optical drive), and then click OK.
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USB Connection Setup
The following procedure uses Windows 7 as an example.

1 Connect the computer and the printer with the USB cable.

2 Turn on the printer.

3 Click Installing Drivers and Software.

4 Select Personal Installation, and then click Next.

5 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

6 If necessary, click Print Test Page to print a test page, click Finish to exit the wizard.

• USB Printing
A personal printer is a printer attached to your computer or a print server using a USB cable.
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Installing Print Driver on Computers Running Mac 
OS X

This section includes:

• "Installing the Driver and Software" on page 52
51 Installing the Print Driver



 Installing the Driver and Software
The following procedure uses Mac OS X 10.8 as an example.

1 Run the Software Pack CD-ROM on the Mac OS X.

2 Double-click the CD-ROM icon displayed on the desktop.

3 Double-click the installer icon.

4 Click Continue on the Introduction screen.

5 Select a language for the Software License Agreement.

6 After reading the Software License Agreement, click Continue.

7 If you agree to the terms of the Software License Agreement, click Agree to continue the 
installation process.

8 Click Install to perform the standard installation.

9 Enter the administrator's name and password, and then click Install Software.

10 Click Continue Installation.

11 Click Restart to complete installation.
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Adding a Printer

Adding a Printer on Mac OS X 10.7/10.8

• When Using a USB connection

1 Turn off the printer and your computer.

2 Connect the printer and your computer with the USB cable.

3 Turn on the printer and your computer.

4 Display System Preferences, and then click Print & Scan.

5 Confirm your USB printer is added to Print & Scan.

If your USB printer is not displayed, execute the following procedures.

6 Click the plus (+) sign, and then click Default (Mac OS X 10.8).

Click the plus (+) sign, and then select Add Other Printer or Scanner. (Mac OS X 10.7).

7 Select the printer connected via USB from the Printer Name (Name for Mac OS X 10.8) list.

Name, Location, and Print Using (Use for Mac OS X 10.8) are automatically entered.

8 Click Add.

Adding a Printer on Mac OS X 10.5.8/10.6

• When Using a USB connection

1 Turn off the printer and your computer.

2 Connect the printer and your computer with the USB cable.

3 Turn on the printer and your computer.

4 Display System Preferences, and then click Print & Fax.

5 Confirm your USB printer is added to Print & Fax.

If your USB printer is not displayed, execute the following procedures.

6 Click the plus (+) sign, and then click Default.

7 Select the printer connected via USB from the Printer Name list.

Name, Location, and Print Using are automatically entered.

8 Click Add.
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Adding a Printer on Mac OS X 10.4.11

• When Using a USB Connection

1 Turn off the printer and your computer.

2 Connect the printer and your computer with the USB cable.

3 Turn on the printer and your computer.

4 Start Printer Setup Utility.

NOTE: 

• You can find Printer Setup Utility in the Utilities folder in Applications.

5 Confirm your USB printer is added to Printer List.

If your USB printer is not displayed, execute the following procedures.

6 Click Add.

7 Click Default Browser in the Printer Browser dialog box.

8 Select the printer connected via USB from the Printer Name list.

Name, Location and Print Using are automatically entered.

9 Click Add.
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5
Printing Basics

This chapter includes:

• "About Print Media" on page 56

• "Supported Print Media" on page 60

• "Loading Print Media" on page 63

• "Printing" on page 79
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About Print Media

This section includes:

• "Print Media Usage Guidelines" on page 57

• "Print Media That Can Damage Your Printer" on page 58

• "Print Media Storage Guidelines" on page 59

Using paper that is not appropriate for the printer can cause paper jams, image quality problems, or 
printer failure. To achieve the best performance from your printer, we recommend you to use only the 
paper described in this section.

When using paper other than that recommended, contact the Fuji Xerox local representative office or 
an authorized dealer.
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Print Media Usage Guidelines
The printer tray accommodates most sizes and types of paper and other specialty media. Follow these 
guidelines when loading paper and media in the tray:

• Before buying large quantities of any print media, it is recommended that you try a sample first.

• For 60 to 135 gsm (16 to 36 lb bond) paper, grain long, where the paper fibers run along the 
length of the paper, is recommended. For paper heavier than 135 gsm (36 lb bond), grain short, 
where the paper fibers run along the width of the paper, is preferred.

• Fan paper or other specialty media before loading in the paper tray.

• Do not print on label stock once a label has been removed from a sheet.

• Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with 
release strips.

• Print all envelopes single-sided only. 

• Some wrinkling and embossing may occur when printing envelopes.

• Do not overload the paper tray. Do not load print media above the fill line on the inside of the 
paper width guides.

• Adjust the paper width guides to fit the paper size.

• If excessive jams or wrinkles occur, use paper or other media from a new package.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 66

• "Loading Envelope in the Multipurpose Feeder (MPF)" on page 69

• "Printing on Custom Size Paper" on page 88

WARNING:

• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 
When paper jam occurs, it may cause short-circuit and eventually a fire accident.
57 Printing Basics



Print Media That Can Damage Your Printer
Your printer is designed to use a variety of media types for print jobs. However, some media can 
cause poor output quality, increased paper jams, or damage to your printer.

Unacceptable media includes:

• Paper that is too heavyweight or too lightweight (less than 60 gsm or more than 190 gsm)

• Transparencies

• Photo paper or coated paper

• Tracing paper

• Illumination film

• Special ink jet printer paper and ink jet transparencies

• Static-cling paper

• Pasted-up or glued paper

• Specially coated paper

• Color paper with surface treatments

• Paper that uses ink that deteriorates with heat

• Photosensitive paper

• Carbon paper or carbonless copy paper

• Paper with a rough surface, such as Japanese paper, pulp paper or fibrous paper

• Envelopes that are not flat, or that have clasps, windows or adhesives with release strips

• Padded envelopes  

• Tack film

• Water transfer paper

• Textile transfer paper

• Perforated paper

• Leather paper, embossed paper

• Conductive paper such as origami paper, carbonic paper or conductively-coated paper

• Wrinkled, creased, folded, or ripped paper

• Damp or wet paper

• Wavy or curled paper

• Paper with staples, clips, ribbons, or tape

• Label paper with some labels already peeled off, or that are partially cut off

• Paper pre-printed by another printer or copying machine

• Paper pre-printed all over rear side

WARNING:

• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 
When paper jam occurs, it may cause short-circuit and eventually a fire accident.
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Print Media Storage Guidelines
Providing good storage conditions for your paper and other media contributes to optimum print quality.

• Store print media in dark, cool, relatively dry locations. Most paper items are susceptible to 
damage from ultraviolet (UV) and visible light. UV radiation, which is emitted by the sun and 
fluorescent bulbs, is particularly damaging to paper items. The intensity and length of exposure 
to visible light on paper items should be reduced as much as possible.

• Maintain constant temperatures and relative humidity.

• Avoid attics, kitchens, garages, and basements for storing print media. 

• Store print media flat. Print media should be stored on pallets, cartons, shelves, or in cabinets.

• Avoid having food or drinks in the area where print media is stored or handled.

• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 
paper in the original packaging. For most commercial cut-size grades, the ream wrapper 
contains an inner lining that protects the paper from moisture loss or gain.

• Leave the media inside the bag until you are ready to use it; reinsert unused media in the bag 
and reseal it for protection. Some specialty media is packaged inside resealable plastic bags. 
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Supported Print Media

Using unsuitable print media may lead to paper jams, poor print quality, breakdown and damage to 
your printer. To use the features of this printer effectively, use the suggested print media that is 
recommended here.

IMPORTANT: 

• The toner may come off the print media, if it gets wet by water, rain, steam and so on. For details, contact the 
Fuji Xerox local representative office or an authorized dealer.
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Usable Print Media
The types of print media that can be used on this printer are as follows:

NOTE: 

• SEF and LEF indicate the paper feed direction; SEF stands for short-edge feed. LEF stands for long-

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Executive SEF (7.25 × 10.5 in)

Legal 13 (Folio) SEF (8.5 × 13 in)

Legal 14 SEF (8.5 × 14 in)

Statement SEF (139.7 × 215.9 mm)

Com-10 SEF (4.125 × 9.5 in)

Monarch SEF (3.875 × 7.5 in)

Monarch LEF (7.5 × 3.875 in)*

DL SEF (110 × 220 mm)

DL LEF (220 × 110 mm)*

C5 SEF (162 × 229 mm)

C5 LEF (229 × 162 mm)

Postcard (100 × 148 mm)

Postcard (148 × 200 mm)

Yougata 2 SEF (114 × 162 mm)

Yougata 2 LEF (162 × 114 mm)*

Yougata 3 SEF (98 × 148 mm)

Yougata 3 LEF (148 × 98 mm)*

Yougata 4 (105 × 235 mm)

Yougata 6 (98 × 190 mm)

Younaga 3 (120 × 235 mm)

Nagagata 3 (120 × 235 mm)

Nagagata 4 (90 × 205 mm)

Kakugata 3 (216 × 277 mm)

Custom size:

Width: 76.2–215.9 mm (3–8.5 inch)

Length: 127–355.6 mm (5 –14 inch)

Paper Type (Weight) Plain (60–105 gsm)

Lightweight Cardstock (106–163 gsm)

Labels 

Envelope

Recycled (60–105 gsm)

Postcard JPN

Loading Capacity 150 sheets of standard paper

* Monarch, DL, Yougata 2, and Yougata 3 envelopes can be supported by LEF with their flap open.
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edge feed.

• Use only laser print media. Do not use ink jet paper in this printer.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 66

• "Loading Envelope in the Multipurpose Feeder (MPF)" on page 69

Printing on print media that differs from the paper size or paper type selected on the print driver may 
lead to paper jams. To ensure that printing is correctly done, select the correct paper size and paper 
type.
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Loading Print Media

Loading print media properly helps prevent jams and ensures trouble-free printing.

Before loading print media, identify the recommended print side of the print media. This information is 
usually on the print media package.

NOTE: 

• After loading paper in the feeder, specify the same paper type on the print driver.
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Capacity
Multipurpose feeder (MPF) can hold:

• 150 sheets of standard paper

• 16.2 mm (0.64 inches) of thick paper

• One sheet of coated paper

• 16.2 mm (0.64 inches) of post cards

• Five envelopes

• 16.2 mm (0.64 inches) of labels
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Print Media Dimensions
The multipurpose feeder (MPF) accepts print media within the following dimensions: 

• Width: 76.2–215.9 mm (3.00–8.50 inches)

• Length: 127–355.6 mm (5.00–14.00 inches)
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Loading Print Media in the Multipurpose Feeder (MPF)

NOTE: 

• To avoid paper jams, do not remove the paper cover while printing is in progress.

• Use only laser print media. Do not use ink jet paper in this printer.

1 Open the front cover.

2 Pull the slide bar forward until it stops.

3 Pull the length guide forward until it stops.

4 Adjust the paper width guides to their maximum width.
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5 Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the 
edges of the stack on a level surface.

6 Load print media on the multipurpose feeder (MPF) with the top edge first and with the 
recommended print side facing up.

7 Adjust the paper width guides until they rest lightly against the edges of the stack of print media.
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8 Slide the length guide towards the printer until it touches the print media.

NOTE: 
• Depending on the size of print media, first slide the slide bar backward until it stops, and then pinch the 

length guide and slide it backward until it touches print media.

9 Insert the paper cover into the printer and then align the paper cover to the marking on the paper 
tray.
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10 Open the output tray extension by two steps. At the secondary step, extend it fully until it clicks.

11 Select the paper type from the print driver if the loaded print media is not standard plain paper. If 
a user-specified print media is loaded in the multipurpose feeder (MPF), you must specify the 
paper size setting by using the print driver.

NOTE: 

• For more information about setting the paper size and type on the print driver, refer to the 
online Help provided for the print driver.

Loading Envelope in the Multipurpose Feeder (MPF)

NOTE: 

• When you print on envelopes, be sure to specify the envelope setting on the print driver. If not specified, the 
print image will be rotated 180 degrees.
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• When Loading Com-10, DL, Monarch, Yougata 2/3/4/6, or Younaga 3
Load envelopes with the side to be printed on facing up, the flap side facing down, and the flap turned 
to the right.

To prevent DL, Monarch, Yougata 2, and Yougata 3 from being wrinkled, they are recommended to be 
loaded with the print-side facing up, flap opened, and facing you.

NOTE: 
• When you load the envelopes in the long-edge feed (LEF) orientation, be sure to specify the landscape 

orientation on the print driver.
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• When Loading C5, Nagagata 3/4 or Kakugata 3
Load envelopes with the side to be printed on facing up, flap opened, and facing you.

IMPORTANT: 
• Never use envelopes with windows, or coated linings. These lead to paper jams and can cause damage to the 

printer.

NOTE: 

• If you do not load envelopes in the multipurpose feeder (MPF) right after they have been removed from the 
packaging, they may bulge. To avoid jams, flatten them as shown below when loading them in the 
multipurpose feeder (MPF).

• If envelopes are still not fed correctly, add some bending to the flap of the envelopes as shown in the following 
illustration.
The amount of the bending shall be 5 mm (0.20 inches) or less.
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• To confirm the correct orientation of each print media such as envelopes, see the instruction on the 
Envelope/Paper Setup Navigator on the print driver.

Loading Postcard in the Multipurpose Feeder (MPF)

NOTE: 

• When you print on postcards, be sure to specify the postcard setting on the print driver to get the optimum 
print result.

• When Loading Postcard
Load the postcard with the side to be printed on facing up, and the top edge of the postcard in first.
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• When Loading W-Postcard
Load the w-postcard with the side to be printed on facing up, and the left edge of the w-postcard in 
first.

NOTE: 

• To confirm the correct orientation of each print media such as postcards, see the instruction on the 
Envelope/Paper Setup Navigator on the print driver.
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Manual Duplex Printing
This section includes:

• "Operations on Your Computer" on page 75

• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 77

NOTE: 

• When printing on curled paper, straighten the paper and then insert it into the feeder.

When you start manual duplex printing, the instruction window appears. Note that the window cannot 
be reopened once it is closed. Do not close the window until duplex printing is complete.
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Operations on Your Computer

• Using the Windows Print Driver
The following procedure uses Microsoft® Windows® 7 WordPad as an example.

NOTE: 

• The way to display the printer Properties/Printing Preferences dialog box differs according to the application 
software. Refer to the manual of your respective application software.

1 From the File menu, select Print.

2 Select the printer from the Select Printer list box, and then click Preferences.

3 Select the Paper/Output tab.

From Duplex, select either Flip on Short Edge or Flip on Long Edge to define the way 2-sided 
print pages are bound. 

4 From Paper Size, select the size of the document to be printed.

5 From Paper Type, select the paper type to be used.

6 Click OK to close the Printing Preferences dialog box.

7 Click Print in the Print dialog box to start printing.

IMPORTANT: 

• When you start manual duplex printing, the instruction window appears. Note that the window cannot be 
reopened once it is closed. Do not close the window until duplex printing is complete.

3

4

5
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• Using the Mac OS X Print Driver
The following procedure uses Mac OS X 10.8 TextEdit as an example.

1 From the File menu, select Print.

2 Select the printer from Printer.

3 From Paper Size, select the size of the document to be printed.

4 Select the Printer Features pane.

5 From Feature Sets, select Paper Handling.

6 From Paper Type, select the paper type to be used.

7 From Duplex, select either Flip on Long Edge or Flip on Short Edge to define the way 2-sided 
print pages are bound.

8 Click Print in the Print dialog box to start printing.

4
5

7

6

Printing Basics 76



Loading Print Media in the Multipurpose Feeder (MPF)

1 First print the even pages (rear sides).

For a six page document, rear sides are printed in the order of page 6, page 4, and then page 2.

The  (Error) LED lights and the  (Ready) LED blinks when the even pages finish printing.

2 After the even pages are printed, remove the paper stack from the center output tray.

NOTE: 

• Warped or curled prints can cause paper jams. Straighten them before setting them.

3 Stack the prints and set them as they are (with the blank side facing up) into the multipurpose 
feeder (MPF), and then press the button on the operator panel.
Pages are printed in order of page 1 (rear of page 2), page 3 (rear of page 4), and then page 5 
(rear of page 6).

NOTE: 

• Printing on both sides of the paper is not possible if the document consists of various sizes of paper.
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Using the Output Tray Extension
The output tray extension is designed to prevent print media from falling from the printer after the print 
job is complete.

Before printing a document, ensure that the output tray extension is fully opened.

The output tray extension is opened by two steps. At the secondary step, extend it fully until it clicks.
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Printing

This section covers how to print certain lists of information from your printer and how to cancel a job.

This section includes:

• "Sending a Job to Print" on page 80

• "Canceling a Print Job" on page 81

• "Selecting Printing Options" on page 83

• "Printing Custom Size Paper" on page 88

• "Checking Status of Print Data" on page 90

• "Printing a Report Page" on page 91

• "Printer Settings" on page 92
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Sending a Job to Print
Install the print driver to use all the features of the printer. When you choose Print from a software 
program, a window representing the print driver opens. Select the appropriate settings for the specific 
job you are sending to print. Print settings selected from the driver have precedence over the default 
menu settings selected from the Printer Setting Utility.

You may need to click Preferences from the initial Print dialog box to see all the available system 
settings you can change. If you are not familiar with a feature in the print driver window, open the 
online Help for more information.

To print a job from a typical Windows application:

1 Open the file you want to print.

2 From the File menu, select Print.

3 Verify that the correct printer is selected in the dialog box. Modify the system settings as needed 
(such as the pages you want to print or the number of copies).

4 To adjust system settings not available from the first screen, such as Image Quality, Paper Size, 
or Image Orientation, click Preferences.

The Printing Preferences dialog box appears.

5 Specify the print settings. For more information, click Help.

6 Click OK to close the Printing Preferences dialog box.

7 Click Print to send the job to the selected printer.
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Canceling a Print Job
There are several methods for canceling a print job.

This section includes:

• "Canceling From the Operator Panel" on page 81

• "Canceling a Job From the Computer Running Windows" on page 81

Canceling From the Operator Panel
To cancel a job after it has started printing:

1 Press the button on the operator panel for about three seconds.

NOTE: 

• Printing is canceled only for the current job. All the following jobs will continue to print.

Canceling a Job From the Computer Running Windows

• Canceling a Job From the Taskbar
When you send a job to print, a small printer icon appears in the right corner of the taskbar.

1 Double-click the printer icon. 

A list of print jobs appears in the printer window.

2 Select the job you want to cancel.

3 Press the Delete key.

4 Click Yes on the Printers dialog box to cancel a print job.
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• Canceling a Job From the Desktop

1 Minimize all programs to reveal the desktop.

For Windows XP, click start → Printers and Faxes.

For Windows Server® 2003, click Start → Printers and Faxes.

For Windows 7 and Windows Server 2008 R2, click Start → Devices and Printers.

For Windows Vista®, click Start → Control Panel → Hardware and Sound → Printers.

For Windows Server 2008, click Start → Control Panel → Printers.

For Windows 8, on the Desktop screen, place the mouse pointer in the upper right corner of the 
screen and move the mouse down, and then select Settings. Click Control Panel → Hardware 
and Sound → Devices and Printers.

For Windows Server 2012, on the Desktop screen, place the mouse pointer in the upper right 
corner of the screen and move the mouse down, and then select Settings. Click Control Panel 
→ Hardware → Devices and Printers.

A list of available printers appears. 

2 Double-click the printer you selected when you sent the job.

A list of print jobs appears in the printer window.

3 Select the job you want to cancel.

4 Press the Delete key.

5 Click Yes on the Printers dialog box to cancel a print job.
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Selecting Printing Options
This section includes:

• "Selecting Printing Preferences (Windows)" on page 83

• "Selecting Options for an Individual Job (Windows)" on page 84

• "Selecting Options for an Individual Job (Mac OS X)" on page 86

Selecting Printing Preferences (Windows)
Printer preferences control all of your print jobs, unless you override them specifically for a job. For 
example, if you want to use duplex printing for most jobs, set this option in printer settings.

To select printer preferences:

1 For Windows XP, click start → Printers and Faxes.

For Windows Server 2003, click Start → Printers and Faxes.

For Windows 7 and Windows Server 2008 R2, click Start → Devices and Printers.

For Windows Vista, click Start → Control Panel → Hardware and Sound → Printers.

For Windows Server 2008, click Start → Control Panel → Printers.

For Windows 8, on the Desktop screen, place the mouse pointer in the upper right corner of the 
screen and move the mouse down, and then select Settings. Click Control Panel → Hardware 
and Sound → Devices and Printers.

For Windows Server 2012, on the Desktop screen, place the mouse pointer in the upper right 
corner of the screen and move the mouse down, and then select Settings. Click Control Panel 
→ Hardware → Devices and Printers.

A list of available printers appears. 

2 Right-click the icon for your printer, and then click Printing Preferences.

The FX DocuPrint P215 b Printing Preferences screen appears.

3 Make selections on the driver tabs, and then click OK to save your selections.

NOTE: 

• For more information about Windows print driver options, click Help on the print driver tab to view the online 
Help.
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Selecting Options for an Individual Job (Windows)
If you want to use special printing options for a particular job, change the driver settings before 
sending the job to the printer. For example, if you want to use Photo print-quality mode for a particular 
graphic, select this setting in the driver before printing that job.

1 With the desired document or graphic open in your application, access the Print dialog box.

2 Select the FX DocuPrint P215 b and click Preferences to open the print driver.

3 Make selections on the driver tabs. See the following table for specific printing options.

NOTE: 

• In Windows, you can save current printing options with a distinctive name and apply them to other print 
jobs. Make selections on the Paper/Output, Graphics, Layout, Watermarks/Forms tab, and then 
click OK under Save on the Paper/Output tab. Click Help for more information.

4 Click OK to save your selections.

5 Print the job.

See the following table for specific printing options:

Printing Options for Windows

Driver Tab Printing Options

Paper/Output tab • Favorites

• Duplex

• Copies

• Collated

• Paper Summary

• Paper Size

• Paper Type

• MPF Orientation

• Envelope/Paper Setup Navigator

• Show Paper Size Error

• Printer Status

• Restore Defaults

Graphics tab • Image Quality

• Toner Saving Mode

• Image Enhancement

• Screen

• Image Settings

– Apply to All Elements

– Apply to Selected Element

– Brightness

– Contrast

• Restore Defaults
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Layout tab • Image Orientation

• Multiple Up

• Poster/Mixed Document

• Output Size

• Reduce / Enlarge

• Margin Shift/Margin

• Restore Defaults

Watermarks/Forms tab • Watermarks

– New Text

– New Bitmap

– Edit

– Delete

– First Page Only

• Forms

– Off

– Create / Register Forms

– Image Overlay

• Header / Footer Options

• Restore Defaults

Driver Tab Printing Options
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Selecting Options for an Individual Job (Mac OS X)
To select print settings for a particular job, change the driver settings before sending the job to the 
printer.

1 With the document open in your application, click File, and then click Print.

2 Select FUJI XEROX DocuPrint P215 b from Printer.

3 Select the desired printing options from the menus and drop-down lists that are displayed.

NOTE: 

• In Mac OS® X, click Save As on the Presets menu screen to save the current printer settings. You can 
create multiple presets and save each with its own distinctive name and printer settings. To print jobs 
using specific printer settings, click the applicable saved preset in the Presets list.

4 Click Print to print the job.

Mac OS X Print Driver Printing Options:

The table shown below uses Mac OS X 10.8 TextEdit as an example.

Printing options for Mac OS X

Item Printing Options

• Copies

• Pages

• Paper Size

• Orientation

Layout • Pages per Sheet

• Layout Direction

• Border

• Two-Sided

• Reverse page orientation

• Flip horizontally

Color Matching • ColorSync

• Vendor Matching

Paper Handling • Collate pages

• Pages to Print

• Page Order

• Scale to fit paper size

• Destination Paper Size

• Scale down only

Cover Page • Print Cover Page

• Cover Page Type

• Billing Info

Image Options • Output Color

• Brightness

• Image Quality

• Image Enhancement

• Color Balance

• Restore Defaults
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Printer Features • 1. Detailed Settings

– Image Rotation (180deg)

• 2. Paper Handling

– Paper Type

– Duplex

– Show Paper Size Error

• 3. Printer Specific Options

– Skip Blank Pages

Supply Levels

Item Printing Options
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Printing Custom Size Paper
This section explains how to print on custom size paper using the print driver.

The way to load custom size paper is the same as the one to load standard size paper.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 66

Defining Custom Paper Sizes
Before printing, set the custom size on the print driver.

NOTE: 

• When setting the paper size on the print driver, be sure to specify the same size as the actual print media 
used. Setting the wrong size for printing can cause printer failure. This is especially true if you configure a 
bigger size when using a narrow width paper.

• Using the Windows Print Driver
On the Windows print driver, set the custom size in the Custom Paper Size dialog box. This section 
explains the procedure using Windows 7 as an example.

For Windows 7 or later, an administrator’s password only allows users with administrator rights to 
change the settings. Users without the rights of administrator can only view the contents.

1 Click start → Devices and Printers.

2 Right-click the icon for your printer, and then select Properties.

3 Select the Configuration tab.

4 Click Custom Paper Size.

5 Select the custom setup you want to define from Details.

6 Specify the length of the short edge and long edge under Change Setting for. You can specify 
the values either by entering them directly or using the up arrow and down arrow buttons. The 
length of the short edge cannot be longer than the long edge, even if it is within the specified 
range. The length of the long edge cannot be shorter than the short edge, even if it is within the 
specified range.

7 To assign a paper name, select the Name the Paper Size check box, and then enter the name in 
Paper Name. Up to 14 characters can be used for the paper name.

8 If necessary, repeat steps 5 to 7 to define another custom size.

9 Click OK twice.

Printing on Custom Size Paper
Use the following procedures to print using either the Windows or Mac OS X print drivers.
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• Using the Windows Print Driver
This section explains the procedure using Windows 7 WordPad as an example.

NOTE: 

• The way to display the printer Properties/Printing Preferences dialog box differs according to the application 
software. Refer to the manual of your respective application software.

1 From the File menu, select Print.

2 Select the printer as the printer to be used and click Preferences.

3 Select the Paper/Output tab.

4 Select the size of the original document from Paper Size.

5 Select the appropriate paper type from Paper Type.

6 Click the Layout tab.

7 From Output Size, select the custom size you defined. If you select the custom size from Paper 
Size in step 4, select Same as Paper Size.

8 Click OK.

9 Click Print in the Print dialog box to start printing.

• Using the Mac OS X Print Driver
This section explains the procedure using Mac OS X 10.8 TextEdit as an example.

1 From the File menu, select Page Setup.

2 Select the printer from Format For.

3 From Paper Size, select Manage Custom Sizes.

4 In the Custom Paper Sizes window, click +.

A newly created setting “Untitled” is displayed in the list.

5 Double-click "Untitled" and enter the name for the setting.

6 Enter the size of the original document in the Width and Height boxes of Paper Size.

7 Specify Non-Printable Area if necessary.

8 Click OK.

9 Make sure that the newly created paper size is chosen in Paper Size, and then click OK.

10 From the File menu, select Print.

11 Press Print to start printing.
89 Printing Basics



Checking Status of Print Data
This section includes:

• "Checking Status (Windows Only)" on page 90

Checking Status (Windows Only)
You can check the printer status with SimpleMonitor. Double-click the SimpleMonitor printer icon on 
the taskbar at the bottom right of the screen. The Printer Selection window appears, which displays 
the printer name, printer connection ports, and printer status. Check the column Status to know the 
current status of your printer. 

Settings button: Displays the Settings screen and allows you to modify the SimpleMonitor settings.

Click the name of the desired printer listed on the Printer Selection window. The Printer Status 
window appears. You can check the printer status and print job status.

For more information about SimpleMonitor, see Help. The following procedure uses Windows 7 as an 
example:

1 Click start → All Programs.

2 Select Fuji Xerox.

3 Select Fuji Xerox Printer Software for Asia-Pacific.

4 Select DocuPrint P215 b.

5 Select Activate SimpleMonitor.

The Printer Selection window appears.

6 Click the name of the desired printer from the list.

The Printer Status window appears.

7 Click Help.

See also: 
• "SimpleMonitor (Windows Only)" on page 42
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Printing a Report Page
To confirm your printer settings, print a report page.

This section describes the method of printing a report page.

Printing a System Settings Page
To verify detailed printer settings, print a System Settings page.

Printer Setting Utility
The following procedure uses Windows 7 as an example.

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
DocuPrint P215 b → Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step, when multiple print drivers are installed on your 
computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Settings Report tab.

3 Select Reports from the list at the left side of the page.

The Reports page is displayed.

4 Click System Settings.

The System Settings page is printed.
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Printer Settings
You can select menu items and corresponding values from the Printer Setting Utility.

The following procedure uses Windows 7 as an example.

NOTE: 

• Factory defaults may vary for different countries.
These settings are active until new ones are selected or the factory defaults are restored.

To select a new value as a setting:

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
DocuPrint P215 b → Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step, when multiple print drivers are installed on your 
computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Maintenance tab.

3 Select the desired menu item.

Each menu item has a list of values for the menu item. A value can be:

• A phrase or word to describe a setting

• A numerical value that can be changed

• An On or Off setting

4 Select the desired value, and then click the associated button with each menu item.

Driver settings may have precedence over changes previously made and may require you to 
change the Printer Setting Utility defaults.
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6
Using the Operator Panel

This chapter includes:

• "Resetting to Factory Defaults" on page 94

• "Understanding the Operator Panel Lights" on page 95
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Resetting to Factory Defaults

After executing Initialize NVM and rebooting the printer, all the menu parameters or data are reset to 
their factory default values.

1 Launch the Printer Setting Utility, and click Reset Defaults on the Printer Maintenance tab.

2 Click the System Section button.

The printer starts initializing the Non-Volatile Memory (NVM).

IMPORTANT: 

• Never attempt to turn off the printer. The printer will cease to function.

The printer restarts automatically to apply the settings.
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Understanding the Operator Panel Lights

The operator panel lights mean different things, depending on their sequence. Umber and green lights 
that are off, on, or blinking indicate printer conditions.

LED Off On Fast Blink Slow Blink

1 Error — None

2 Ready —

1

2
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Light Sequences
The following table shows the light status.

1 2 Printer Status

Error Ready

— Ready

The toner is low.

See also: 
• "Replacing the Toner Cartridge" on page 136

— Downloading

Warming up after power on

Receiving data, Waiting for data, Printing

Printing when the toner is low.

See also: 
• "Replacing the Toner Cartridge" on page 136

Returning from Sleep mode

— In Power Saver mode

See also: 
• "Power Saver Mode" on page 35

No paper is loaded.

Load paper, and then press the button on the operator panel.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" 

on page 66

The wrong size of paper is loaded.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" 

on page 66

Paper jam occurred.

See also: 
• "Clearing Jams" on page 100

Waiting for manual duplex printing *1

Canceling job

— The toner is empty.

See also: 
• "Replacing the Toner Cartridge" on page 136

The rear cover is opened.

Close the rear cover.

All other engine error: fan error, fusing unit error etc.

Turn off the printer, and then on.
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— A fatal error occurred.

Turn off the printer, and then on. Contact the Fuji Xerox local 
representative office or an authorized dealer if this error 
occurs repeatedly.

*1 Load paper for the second side (odd) pages, and press the button on the operator panel.

See also: 

• "Manual Duplex Printing" on page 74

1 2 Printer Status

Error Ready
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7
Troubleshooting

This chapter includes:

• "Clearing Jams" on page 100

• "Basic Printer Problems" on page 109

• "Display Problems" on page 110

• "Printing Problems" on page 111

• "Print Quality Problems" on page 112

• "Other Problems" on page 126

• "Contacting Service" on page 127

• "Getting Help" on page 128

• "Non-Genuine Mode" on page 132
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Clearing Jams

This section includes:

• "Avoiding Jams" on page 101

• "Identifying the Location of Paper Jams" on page 102

• "Clearing Paper Jams From the Front of the Printer" on page 103

• "Clearing Paper Jams From the Back of the Printer" on page 104

• "Clearing Paper Jams From the Center Output Tray" on page 106

• "Jam Problems" on page 108

Careful selection of appropriate print media and proper loading allow you to avoid most jams. 

See also: 
• "About Print Media" on page 56

• "Supported Print Media" on page 60

NOTE: 

• Before buying large quantities of any print media, it is recommended that you try a sample first.
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Avoiding Jams
• Use only recommended print media.

• See "Loading Print Media in the Multipurpose Feeder (MPF)" on page 66 to load print media 
properly.

• Do not overload the print media sources. Ensure that the stacked print media height does not 
exceed the marks indicated on the paper width guides.

• Do not load wrinkled, creased, damp, or curled print media.

• Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try 
feeding one sheet at a time through the multipurpose feeder (MPF).

• Do not use print media that you have cut or trimmed.

• Do not mix print media sizes, weights, or types in the same print media source.

• Ensure that the recommended print side is face up when you insert the print media.

• Keep print media stored in an acceptable environment.

• Ensure that all cables that connect to the printer are correctly attached.

• Overtightening the guides may cause jams.

See also: 

• "About Print Media" on page 56 

• "Supported Print Media" on page 60

• "Print Media Storage Guidelines" on page 59
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 Identifying the Location of Paper Jams

IMPORTANT: 
• Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path.

CAUTION:

• Do not attempt to remove a paper deeply jammed inside the product, particularly a paper wrapped 
around the fusing unit or the heat roller. Otherwise, it may cause injuries or burns. Switch off the 
product immediately and contact your local Fuji Xerox representative.

1 Center Output Tray

2 Transfer Drum

3 Levers

4 Rear Cover

5 Front Cover

6 Multipurpose Feeder (MPF)

1
2

56

3

4
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Clearing Paper Jams From the Front of the Printer

NOTE: 

• To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1 Remove the paper cover.

2 Remove any paper jammed from the front of the printer.

3 Replace the paper cover in the printer.

4 To restore the printer, press the button on the operator panel according to the instructions of the 
Printer Status window.

IMPORTANT: 

• Do not use excessive force on the paper cover. Doing so could damage it or the inside of the printer.
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Clearing Paper Jams From the Back of the Printer

IMPORTANT: 

• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 
before performing maintenance.

• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot 
during use.

NOTE: 

• To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear cover.

2 Lift up the levers.

3 Remove any paper jammed from the back of the printer.
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4 Lower the levers to their original position.

5 Close the rear cover.
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Clearing Paper Jams From the Center Output Tray

IMPORTANT: 

• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 
before performing maintenance.

• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot 
during use.

NOTE: 

• To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear cover.

2 Lift up the levers.

3 Remove any paper jammed from the back of the printer. If no paper is found in the paper path, 
then remove any paper jammed out of the center output tray.
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4 Lower the levers to their original position.

5 Close the rear cover.
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Jam Problems
This section includes:

• "Misfeed jam" on page 108

• "Multi-feed jam" on page 108

Misfeed jam

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Multi-feed jam

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

Print media misfeeds occur. Ensure that the paper is inserted properly in the multipurpose feeder 
(MPF).

Depending on the print media you use, take any of the following 
actions:

• For thick paper, use the one that is 163 gsm or less.

• For postcard, the one up to 190 gsm is available.

• For thin paper, use the one that is 60 gsm or more.

• For the envelope, ensure that it is properly loaded in the 
multipurpose feeder (MPF) as instructed in "Loading Envelope in 
the Multipurpose Feeder (MPF)" on page 69.

If the envelope is deformed, correct it or use another envelope.

If performing manual duplex printing, ensure that the print media is 
not curled.

Fan the print media.

If the print media is damp, turn over the print media.

If the problem continues, use print media that is not damp. 

Problem Action

Print media multiple feeds occur. Ensure that the paper is inserted properly in the multipurpose feeder 
(MPF).

If the print media is damp, use print media that is not damp.

Fan the print media. 
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Basic Printer Problems

Some printer problems can be easy to resolve. If a problem occurs with your printer, check each of the 
followings:

• The power cord is connected to the printer, and to a properly grounded electrical outlet.

• The printer is turned on.

• The electrical outlet is not turned off at any switch or breaker.

• Other electrical equipment plugged into the outlet is working.

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, 
and then turn on the printer. This often fixes the problem.
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Display Problems

Problem Action

After the printer is turned on, the 
 (Ready) LED is not lit.

Turn off the printer, wait for 10 seconds, and turn on the printer.
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Printing Problems

Problem Action

Printer stops during print job. Check if the message appears on the Printer Setting Utility. If the 
"Cooling Down Wait a few minutes" message appears, the printer is 
cooling down because the printer temperature is too high. Please wait 
a few minutes.
After the printer cools down, the printing will restart.

Job did not print or incorrect 
characters printed.

Ensure that the  (Ready) LED is lit.

Ensure that print media is loaded in the printer.

Verify that you are using the correct print driver.

Ensure that you are using the correct USB cable and that it is 
securely connected to the printer.

Verify that the correct print media size is selected.

If you are using a print spooler, verify that the spooler has not stalled.

Print media misfeeds or multiple 
feeds occur.

Ensure that the print media you are using meets the specifications for 
your printer. 

See also: 
• "Usable Print Media" on page 61

Fan the print media before loading it.

Ensure that the print media is loaded correctly.

Ensure that the paper width guides and length guide are adjusted 
correctly.

Do not overfill the print media sources.

Do not force print media into the multipurpose feeder (MPF) when 
you load it. Otherwise, it may skew or buckle.

Ensure that the print media is not curled.

Load the recommended print side correctly for the type of print media 
you are using.

See also: 
• "Loading Print Media" on page 63

Turn the print media over or around and try printing again to see if 
feeding improves.

Do not mix print media types.

Do not mix reams of print media.

Remove the top and bottom curled sheets of a ream before loading 
the print media.

Load a print media source only when it is empty.

The envelope is creased after 
printing.

Ensure that the envelope is loaded as instructed in "Loading 
Envelope in the Multipurpose Feeder (MPF)" on page 69.

Page breaks in unexpected 
places.

Increase the value for Fault Time-Out in the System Settings menu 
that is on the Printer Maintenance tab in the Printer Setting Utility.

Print media does not stack neatly 
in the center output tray.

Turn the print media stack over in the multipurpose feeder (MPF).

Printer does not duplex pages. Select Flip on Short Edge or Flip on Long Edge from the Duplex 
menu on the Paper/Output tab in the print driver.
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Print Quality Problems

This section includes:

• "The Output Is Too Light" on page 113

• "Toner Smears or Print Comes Off/Stain on Back Side" on page 114

• "Random Spots/Blurred Images" on page 115

• "The Entire Output Is Blank" on page 116

• "Streaks Appear on the Output" on page 117

• "Mottle" on page 118

• "Ghosting" on page 119

• "Fog" on page 120

• "Bead-Carry-Out (BCO)" on page 121

• "Auger Mark" on page 122

• "Wrinkled/Stained Paper" on page 123

• "The Top Margin Is Incorrect" on page 124

• "Protrudent/Bumpy Paper" on page 125

NOTE: 

• In this section, some procedures use the Printer Setting Utility or the SimpleMonitor. 

See also: 
• "Printer Setting Utility (Windows Only)" on page 41

• "SimpleMonitor (Windows Only)" on page 42
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The Output Is Too Light

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The output is too light. The toner cartridge may be low or need to be replaced. Confirm the 
amount of toner in the toner cartridge. 

1 Check the Estimated Toner Level on the Consumables tab in the 
Printer Status window.

2 Replace the toner cartridge as necessary.

Verify that the print media is dry and the correct print media is used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 61

Try changing the Paper Type setting in the print driver.

On the Paper/Output tab in Printing Preferences of the print driver, 
change the Paper Type setting.

Disable Toner Saving Mode in the print driver.

1On the Graphics tab in Printing Preferences of the print driver, 
ensure that the Toner Saving Mode check box is not selected.
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Toner Smears or Print Comes Off/Stain on Back Side

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

Toner smears or print comes off.
The output has stain on the back 
side.

The print media surface may be uneven. Try changing the Paper 
Type setting in the print driver. For example, change the Plain to 
Lightweight Cardstock.

1 On the Paper/Output tab in Printing Preferences of the print 
driver, change the Paper Type setting.

Verify that the correct print media is being used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 61

Adjust the temperature of the fusing unit.

1 Launch the Printer Setting Utility, and click Adjust Fusing Unit on 
the Printer Maintenance tab.

2 Adjust the fixing temperature by turning up the value for your 
printing media.

3 Click Apply New Settings button.
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Random Spots/Blurred Images

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The printed result has random 
spots or is blurred.

Ensure that the toner cartridge is installed correctly. 

See also: 
• "Installing a Toner Cartridge" on page 140

If you use a non-genuine brand toner cartridge, install a genuine 
brand toner cartridge.
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The Entire Output Is Blank

If this trouble happens, contact the Fuji Xerox local representative office or an authorized dealer.
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Streaks Appear on the Output

If this trouble happens, contact the Fuji Xerox local representative office or an authorized dealer.
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Mottle

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The printed result has mottled 
appearance.

Adjust the transfer bias.

1 Launch the Printer Setting Utility, click Adjust BTR on the Printer 
Maintenance tab.

2 Adjust the setting for the type of print media being used.

3 Click Apply New Settings button.

If you use non-recommended print media, use the print media 
recommended for the printer.
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Ghosting

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The printed result has ghosting. Adjust the transfer bias.

1 Launch the Printer Setting Utility, and click Chart Print on the 
Diagnosis tab.

2 Click the Ghost Configuration Chart button.

The Ghost Configuration Chart is printed.

3 Launch the Printer Setting Utility, and click BTR Refresh Mode on 
the Printer Maintenance tab.

4 Select the check box next to On, and then click Apply New 
Settings button.

5 Click Chart Print on the Diagnosis tab.

6 Click the Ghost Configuration Chart button.

The Ghost Configuration Chart is printed.

The print media surface may be uneven. Try changing the Paper 
Type setting in the print driver. For example, change the Plain to 
Lightweight Cardstock.

1 On the Paper/Output tab in Printing Preferences of the print 
driver, change the Paper Type setting.

Adjust the temperature of the fusing unit.

1 Launch the Printer Setting Utility, and click Adjust Fusing Unit on 
the Printer Maintenance tab.

2 Adjust the fixing temperature by turning up the value for your 
printing media.

3 Click Apply New Settings button.

If you use non-recommended print media, use the print media 
recommended for the printer.
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Fog

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The printed result is foggy. When the whole is printed light, contact the Fuji Xerox local 
representative office or an authorized dealer.

When the printed page is partly light, start Clean Developer.

1 Launch the Printer Setting Utility, and click Clean Developer on 
the Diagnosis tab.

2 Click the Start button.
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Bead-Carry-Out (BCO)

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

Bead-Carry-Out (BCO) is 
happening.

If the printer is installed in a high altitude location, set the altitude of 
the location.

1 Launch the Printer Setting Utility, and click Adjust Altitude on the 
Printer Maintenance tab.

2 Select the value close to the altitude of the location where the 
printer is installed.

3 Click Apply New Settings button.
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Auger Mark

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The printed result has auger 
mark.

The toner cartridge may be low or need to be replaced. Confirm the 
amount of toner in the toner cartridge.

1 Check the Estimated Toner Level on the Consumables tab in the 
Printer Status window.

2 Replace the toner cartridge as necessary.

Start Clean Developer.

1 Launch the Printer Setting Utility, and click Clean Developer on 
the Diagnosis tab.

2 Click the Start button.
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Wrinkled/Stained Paper

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The output is wrinkled.
The output is stained.

Verify that the correct print media is being used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 61

• "About Print Media" on page 56

If you use the envelope, check whether the crease is within 30 mm of 
the four edges of the envelope.

If the crease is within 30 mm of the four edges of the envelope, this is 
considered normal. Your printer is not at fault.

If not, take the following actions:

• If the envelope is Com-10 envelope, which is 220 mm or longer 
and has a flap on the long edge, load it being rotated 180 degree.

• If the envelope is Com-10 envelope, which is 220 mm or longer 
and has a flap on the long edge, use a different size envelope.

• If the envelope is C5, which is 220 mm or longer and has a flap on 
the short edge, load it in the multipurpose feeder (MPF) with the 
flap open and facing up.

• If the envelope is Monarch or DL, which is shorter than 220 mm, 
load it long edge feed in the multipurpose feeder (MPF) with the 
flap open and facing up.
If the problem continues, use a different size envelope.
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The Top Margin Is Incorrect

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The top margin is incorrect. Ensure that the margins are set correctly on the application being 
used.
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Protrudent/Bumpy Paper

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

Printed surface got 
protrudent/bumpy.

Clean up the fusing unit.

1 Load one sheet of paper on the multipurpose feeder (MPF), and 
then print a solid image all over paper.

2 Load the printed sheet with the side to be printed on facing down, 
and then print a blank sheet of paper.
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Other Problems

Problem Action

Condensation has occurred 
inside the printer.

This usually occurs within several hours after you heat the room in 
winter. This also occurs when the printer is operating in a location 
where relative humidity reaches 85% or more. Adjust the humidity or 
relocate the printer to an appropriate environment.
Troubleshooting 126



Contacting Service

When you call for printer service, be prepared to describe the problem you are experiencing or the 
LED status on the operator panel.

You need to know the model of your printer and serial number. See the label on the rear cover of your 
printer.
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Getting Help

This section includes:

• "Operator Panel Lights" on page 129

• "SimpleMonitor Alerts" on page 130

• "Obtaining the Product Information" on page 131

Fuji Xerox provides several automatic diagnostic tools to help you produce and maintain print quality.
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Operator Panel Lights
The operator panel provides you with information and troubleshooting help. When an error or warning 
condition occurs, the operator panel LEDs inform you of the problem.

See also: 
• "Understanding the Operator Panel Lights" on page 95
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SimpleMonitor Alerts
The SimpleMonitor is a tool that is included on the Software Pack CD-ROM. It automatically checks 
the printer status when you send a print job. If the printer is unable to print your job, the SimpleMonitor 
automatically displays an alert on your computer screen to let you know that the printer needs 
attention.
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Obtaining the Product Information

Obtaining the Latest Print Driver
The latest print driver can be obtained by downloading it from our web site.

The following procedure uses the Windows print driver as an example.

NOTE: 

• The communication fee shall be borne by users. 

1 In your print driver's Printing Preferences dialog box, click the Advanced tab and then click 
About.

2 Click Fuji Xerox Web Site. 

Your web browser launches and our web site is displayed.

3 Follow the instructions on the web site and download an appropriate print driver.

NOTE: 

• The URL of the driver download service page is as follows: http://www.fujixeroxprinters.com/.

• For the latest information about the print driver features, refer to the online Help provided for the print driver.

Updating the Printer's Firmware
Our web site also provides a tool that allows you to update the printer's firmware (software embedded 
within the printer) from your computer.

The latest firmware and updating tool can be downloaded from the following URL.

Follow the instructions on the web site and download the correct firmware update.

http://www.fujixeroxprinters.com/

NOTE: 

• The communication fee shall be borne by users.
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Non-Genuine Mode

When you want to use the printer in Non-Genuine Mode, enable the Non-Genuine Mode and replace 
the toner cartridge.

IMPORTANT: 

• If you use the printer in the Non-Genuine Mode, the performance of the printer may not be at its optimum. And 
any problems that may arise from the use of the Non-Genuine Mode are not covered by our quality guarantee. 
The continuous use of the Non-Genuine Mode can also cause the printer to break down, and any repair 
charges for such break down will be incurred by users.

NOTE: 

• To disable the Non-Genuine Mode, deselect the check box next to On on the Non-Genuine Mode page on 
the Printer Maintenance tab in the Printer Setting Utility.

This section includes:

• "The Printer Setting Utility" on page 133
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The Printer Setting Utility
The following procedure uses Windows 7 as an example.

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
DocuPrint P215 b→ Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step, when multiple print drivers are installed on your 
computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Maintenance tab.

3 Select Non-Genuine Mode from the list at the left side of the page.

The Non-Genuine Mode page is displayed.

4 Select the check box next to On, and then click the Apply New Settings button.
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8
Maintenance

This chapter includes:

• "Replacing the Toner Cartridge" on page 136

• "Ordering Supplies" on page 142

• "Storing Consumables" on page 146

• "Managing the Printer" on page 147

• "Conserving Supplies" on page 149

• "Checking Page Counts" on page 150

• "Moving the Printer" on page 151
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Replacing the Toner Cartridge

Fuji Xerox toner cartridges are available only through Fuji Xerox. To order by phone, see "Online 
Services" on page 157.

It is recommended that you use a Fuji Xerox toner cartridge for your printer. Fuji Xerox does not 
provide warranty coverage for problems caused by using accessories, parts, or components not 
supplied by Fuji Xerox.

IMPORTANT: 

• Do not shake the used toner cartridge to avoid spilling of the toner.

• It is recommended that the toner cartridge is replaced with a new one after it gets empty.

This section includes:

• "Overview" on page 137

• "Removing the Toner Cartridge" on page 138

• "Installing a Toner Cartridge" on page 140

WARNING:

• Never use a vacuum cleaner for spilled toner and residual toner in this product or toner cartridge. It 
may catch fire by electric sparks inside a vacuum cleaner and cause explosion. Use a broom or a wet 
cloth to wipe off the spills.  If you spill a large volume of toner, contact Fuji Xerox Customer Support 
Center.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and 
cause burn injuries or explosion.
If you have a used toner cartridge no longer needed, contact your local Fuji Xerox representative for 
its disposal.

CAUTION:

• Keep drum cartridges (or drum if not a cartridge type) and toner cartridges out of the reach of 
children. If a child accidentally swallows toner, spit it out, rinse mouth with water, drink water and 
consult a physician immediately.

• When replacing drum cartridges (or drum if not a cartridge type) and toner cartridges, be careful not 
to spill the toner. In case of any toner spills, avoid contact with clothes, skin, eyes and mouth as well 
as inhalation.

• If toner spills onto your skin or clothing, wash it off with soap and water. 
If you get toner particles in the eyes, wash it out with plenty of water for at least 15 minutes until 
irritation is gone. Consult a physician if necessary. 
If you inhale toner particles, move to a fresh air location and rinse your mouth with water.
If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
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Overview
The printer has one color toner cartridge: black (K).

When the toner cartridge reaches its usable life-span, the LEDs on the operator panel light on, and the 
following messages appear on the Printer Status window.

IMPORTANT: 

• When placing a used toner cartridge on a floor or on a table, place a few sheets of paper under the toner 
cartridge to catch any toner that may spill.

• Do not reuse old toner cartridges once you remove them from the printer. Doing so can impair print quality.

• Do not shake or pound the used toner cartridges. The remaining toner may spill.

• We recommend you to use up the toner cartridges within one year after removing them from the packaging.

• It is recommended that you do not replace the toner cartridge until the below message appears;
Replace the toner cartridge. Or check that the cartridge is correctly set and press the button.

LED Message Remaining Page 
Yield

Printer Status and Action

Error Ready

— The Black Cartridge needs 
to be replaced soon.*1

Approx. 400 
pages*2

The toner cartridge has become low. 
Use this toner cartridge until the below 
message appears.

Replace the toner cartridge. Or check 
that the cartridge is correctly set and 
press the button.

— Replace the toner 
cartridge. Or check that 
the cartridge is correctly 
set.

— The toner cartridge has become empty. 
Replace the old toner cartridge with a 
new one.

*1 This warning appears only when Fuji Xerox toner cartridge is used (Non-Genuine Mode is set to off at the 
Printer Setting Utility).

*2 When the starter toner cartridge shipped with the printer is set, the remaining page yield is approx. 200 
pages.
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Removing the Toner Cartridge

1 Open the front cover.

2 Open the toner access cover.

3 Spread a few sheets of paper on the floor or table where the removed toner cartridge is placed.

4 Turn the toner cartridge counterclockwise to unlock.
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5 Pull the toner cartridge out.

IMPORTANT: 

• Do not touch the shutter of the used toner cartridge.

• Always pull the toner cartridge out slowly so you do not spill any toner.

6 Place the toner cartridge slowly on the sheets of paper spread in step 3.
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 Installing a Toner Cartridge

1 Unpack a new toner cartridge and shake it five times to distribute the toner evenly.

NOTE: 

• Handle the toner cartridge carefully to avoid spilling of the toner.

2 Adjust the toner cartridge to the cartridge holder, and then turn it clockwise to align to the lock 
mark.

IMPORTANT: 

• Be sure to set the toner cartridge firmly before printing. Otherwise, it may cause some defects.

3 Close the toner access cover until it clicks.
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IMPORTANT: 

• If you replace the toner cartridge when the toner low message "The Black Cartridge needs to be replaced 
soon." is displayed on the Printer Status window, the message may remain displayed. For more 
information on the toner low message, see "Overview" on page 137.

See also: 

• "Printing a System Settings Page" on page 91

• "Checking Page Counts" on page 150

4 Close the front cover.

5 Pack the removed toner cartridge in the box in which the installed toner cartridge was packed up.

6 Take care not to contact with the spilled toner and remove the sheets of paper spread under the 
removed toner cartridge.
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Ordering Supplies

This section includes:

• "Consumables" on page 143

• "When to Order a Toner Cartridge" on page 144

• "Recycling Supplies" on page 145

The toner cartridge needs to be ordered occasionally. The toner cartridge includes installation 
instructions on the box.
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Consumables

IMPORTANT: 

• Use of consumables not recommended by Fuji Xerox can impair machine quality and performance. Use only 
consumables recommended by Fuji Xerox.

IMPORTANT: 

• The number of printable pages are applicable when A4 plain paper SEF ( ) is used and printing is done 
continuously in the print ratio of 5% in image density. Also, it satisfies the public values on the basis of JIS 
X6931 (ISO/IEC 19752). These values are estimates and vary depending on conditions such as the content 
being printed, paper size, paper type, the printer’s operating environment, initializing process done when you 
turn on or off the printer, and adjustments to maintain print quality.

NOTE: 

• The printable number of pages for the starter toner cartridge shipped with the printer is approximately 700 
pages.

• Each toner cartridge includes installation instructions on the box.

Product Name Product Code Printable Number of Pages

Toner Cartridge - Standard Capacity

Toner Cartridge - High Capacity

CT201609

CT201610

Approx. 1,000 pages

Approx. 2,200 pages

*: Available for the P215/M215 series.
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When to Order a Toner Cartridge
The operator panel LEDs and the Printer Status window inform warnings when the toner cartridge 
nears its replacement time. Verify that you have a replacement on hand. It is important to order a toner 
cartridge when these warnings first appear to avoid interruptions to your printing. The Printer Status 
window displays an error message when the toner cartridge must be replaced.

To order a toner cartridge, contact the Fuji Xerox local representative office or an authorized dealer.

See also: 
• "Online Services" on page 157

IMPORTANT: 

• This printer is designed to provide the most stable performance and print quality when used with the 
recommended toner cartridge. Not using the toner cartridge recommended for this machine degrades the 
performance and printing quality of the printer. You could also incur charges if the machine breaks down. To 
receive customer support and achieve the optimum performance of the printer, be sure to use the 
recommended toner cartridge.
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Recycling Supplies
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner 

cartridges or toner containers and drums (photoreceptors) to make recycle parts, recycle 
materials or energy recovery.

• Proper disposal is required for toner cartridges no longer needed. Do not open toner cartridges 
containers. Return them to your local Fuji Xerox representative.

• To recover scarce resources, rechargeable batteries used in the returned machines are recycled 
as materials or reused for energy generation.
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Storing Consumables

Store consumables in their original packaging until you need to use them. Do not store consumables 
in:

• Temperatures greater than 40 °C (140 °F).

• An environment with extreme changes in humidity or temperature.

• Direct sunlight.

• Dusty places.

• A car for a long period of time.

• An environment where corrosive gases are present.

• An environment with salty air.
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Managing the Printer

This section includes:

• "Checking Printer Status with SimpleMonitor (Windows Only)" on page 148
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Checking Printer Status with SimpleMonitor (Windows 
Only)

SimpleMonitor is a tool that is installed with your Fuji Xerox print driver. It automatically checks the 
printer status when you send a print job. SimpleMonitor can check the remaining amount of the toner 
cartridge.

Starting SimpleMonitor
Double-click the SimpleMonitor icon on the taskbar or right-click the icon and select Printer 
Selection.

If the SimpleMonitor icon is not displayed on the taskbar, open SimpleMonitor from the start menu. 

The following procedure uses Microsoft® Windows® 7 as an example.

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
DocuPrint P215 b → Activate SimpleMonitor.

The Printer Selection window appears.

2 Click the name of the desired printer from the list.

The Printer Status window appears.

For more information about SimpleMonitor, refer to the online Help.

See also: 
• "SimpleMonitor (Windows Only)" on page 42
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Conserving Supplies

You can change several settings in your print driver to conserve toner and paper.

Supply Setting Function

Toner cartridge Toner Saving Mode in 
the Graphics tab of the 
print driver

This check box allows the users to select a print mode 
that uses less toner. When this feature is used, the 
image quality will be lower than when it is not used.

Print media Multiple Up in the Layout 
tab of the print driver

The printer prints two or more pages on one side of a 
sheet. The available numbers that each print driver can 
print one sheet of paper are as follows:

• Windows Print Driver: 2, 4, 8, or 16 pages

• Mac OS® X Print Driver: 2, 4, 6, 9 or 16 pages

Combined with the duplex setting, Multiple Up allows 
you to print up to 32 pages on one sheet of paper. (16 
images on the front and 16 on the back)
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Checking Page Counts

The total number of printed pages can be checked by printing a System Settings page. The total 
number of printed pages is shown on the Print Volume section, classified by paper sizes.

Single side print (including Multiple-Up) is counted as one job, and 2-sided print (including Multiple-
Up) is counted as two. During 2-sided printing, if an error occurs after one side is printed properly, it is 
counted as one.

When doing 2-sided printing, a blank page may be inserted automatically depending on the settings of 
the application. In this case, the blank page is counted as one page. However, when doing 2-sided 
printing for odd number of pages, the blank page inserted to the rear side of the last odd page is not 
counted.

NOTE: 

• Refer to "Printing a System Settings Page" on page 91 for details on how to print a System Settings page.

• You can also confirm the toner counter reset by printing a System Settings page. When the toner counter is 
reset, each number of paper sizes on the Print Volume section will be also reset. Resetting the toner counter 
is possible from the Printer Setting Utility.
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Moving the Printer

NOTE: 

• The rear side of this printer is heavier than the front. Take note of this difference in weight when moving the 
printer.

1 Turn off the printer.

2 Disconnect the power cord and the USB cable.

3 Remove any paper in the center output tray if there is. Close the output tray extension.

4 Remove the paper cover.
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5 Remove any paper in the multipurpose feeder (MPF). Keep the paper wrapped and away from 
humidity and dirt.
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6 Slide the slide bar and the length guide backward until each of them stops.

7 Close the front cover.

8 Lift the printer and move it gently.

NOTE: 

• If the printer is to be moved over a long distance, the toner cartridge should be removed to prevent toner 
from spilling and the printer should be packed inside a box.
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9
Contacting Fuji Xerox
This chapter includes:

• "Technical Support" on page 156

• "Online Services" on page 157
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Technical Support

Fuji Xerox recommends the Customer first utilize support materials shipped with the product, product 
diagnostics, information contained on the Web, and email support. If unsuccessful, to obtain service 
under product warranty the Customer must notify Fuji Xerox Telephone Support or its authorized 
service representative of the defect before the expiration of the warranty period. Customer will provide 
appropriate assistance to Telephone Support personnel to resolve issues, such as restoration of the 
operating system, software program and drivers to their default configuration and settings, verification 
of functionality of Fuji Xerox supplied products, replacement of customer replaceable units, clearing 
paper misfeeds and cleaning the unit and other prescribed routine and preventative maintenance.

If the Customer’s product contains features that enable Fuji Xerox or its authorized service 
representative to diagnose and repair problems with the product remotely, Fuji Xerox may request that 
the Customer allow such remote access to the product.
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Online Services

You can find detail Product and Consumable warranty information and activate your warranty by 
registering your details on our website at http://www.fujixerox.com/support/docuprint/

Fuji Xerox Online Support Assistant provides instructions and troubleshooting guides to resolve your 
printer problems. It is an easy-to-use, searchable online help. To find out more, please visit our online 
support at http://www.fujixerox.com/support/docuprint/
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